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How to Do Everything with Photoshop Elements 4.0

How to…
■ Build and print online photo albums, calendars, and greeting cards
■ Create a web gallery of your photos
■ E-mail your creations to your friends
■ Share your images in an online service
■ Order prints online

A

s you’ve seen, you can build a lot of neat stuff with your
photographs. You aren’t limited to just printing them on
your computer, however. By signing up for an account with the
Adobe online service, you can order some creations printed
online, resulting in very professional results. For example, you
can order a photo album with a leather cover!
You can also e-mail your creations to friends and family, as
well as order prints online and have them delivered to people
you entered in your contact book or designated as “print targets.”
And if you just want to post your photographs to your own web
site, you can create a set of web pages in a variety of styles, and
then upload them to your site to do just that.

E-mail Your Creations
You can e-mail your creations to your friends and family, making
it easy to share them. Of course, they might not have a copy of
Photoshop Elements, but they don’t need it—the creations are
automatically converted into a format that almost anyone with
a computer can open and enjoy.

E-mail 4-Fold Greeting
Cards or Album Pages
The starting point for e-mailing a 4-Fold Greeting Card
creation is the Share Panel of the Create A 4-Fold Greeting
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Card dialog box. You’ll see this panel while building the card,
or you can select the thumbnail for a saved card in Organizer
and choose Share from the shortcut menu or the Edit menu.
Once you’re viewing the panel, click the E-mail button. This
opens the Attach Creation Item To E-mail dialog box:
Choose e-mail recipients

Type the attachment file name
Specify size and quality

Type your message here

Other than starting from the Share Panel of the Create Album Pages dialog box,
e-mailing an Album Pages creation works exactly the same way as 4-Fold Greeting
Cards. In addition, e-mailing Photo Greeting Cards and Bound Photo Books (covered
later in this chapter in the section “Build a Bound Photo Book or Bound Calendar”) also works
exactly the same way.
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From this dialog box, you can specify the attachment
filename and set whether to optimize the greeting card for
viewing onscreen, printing, or to just send it in full resolution.
You can also enter a message by typing it into the Message
text box.
If you have added contacts to the Photoshop Elements
Contact book, they will appear in the Select Recipients portion
of the dialog box. To send an e-mail to one of the recipients,
select the check box alongside the name. You can also click the
Edit Contacts button to present a dialog box where you can fill
in the information to add a recipient to the list.
Click Next. Photoshop Elements creates an Adobe Acrobat
(PDF) document of your greeting card. It then notifies you
of the size of the resulting file (click OK), opens your default
e-mail application (Outlook Express in my case), and creates an
e-mail addressed to the recipients you selected. It also attaches
the PDF document to the e-mail. You can then customize the
message and subject line, and click Send to send the e-mail on
its way.
You can download a free copy of the Adobe Acrobat reader at http://www.adobe.com/
products/acrobat/readstep2.html.

Add Contacts to Your Contact Book
The easiest way to e-mail your creations to people is to add them to your contact list. To do
so, click the Edit Contacts button in the Attach Creation Item To E-mail dialog box, which
opens the Contact Book dialog box, shown next.
You can also directly edit the contact list by selecting Edit | Contact Book
in Organizer.
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To build a new contact, click the New Contact button, which opens the New Contact
dialog box, shown next. Fill in the items and click OK to add the person to your contact list.
Most important is the e-mail address—if you don’t fill that in, you won’t be able to choose
the contact when sending an e-mail.
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To edit existing contacts, double-click the contact or select the contact and
click the Edit button. Either technique opens the Edit Contact dialog box.
Other than the title, this dialog box is identical to the New Contact dialog box.
You can also build new “groups,” which are collections of contacts. If you choose to
e-mail something to a group, everyone in the group gets the e-mail. To build a group, click
the New Group button to open the New Group dialog box, shown next. Type the name
into the Group Name field, select contacts from the list on the right, and click the Add
button to make them members of the group.

Finally, if you’ve set up the address book in Outlook Express, you can import it into your
contact list. To do so, click the Import button, choose Outlook Express from the resulting
dialog box, and click OK to import the contacts. If you have Netscape VCard files, you can
import those exactly the same way.

E-mail a Slide Show
E-mailing a slide show works just a little differently from the
creations mentioned previously. You start from the Slide Show
Output dialog box (click the Output button in the Slide Show
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Editor), and choose E-mail Slide Show. This displays exactly
the same options as we saw in “Output Your Slide Show” in
Chapter 24:

Proceed with the following steps:
1. Make your choices for file type (.wmv or .pdf) and fill
in the options for each type as described in Chapter 24.
2. Click OK to open the Save As dialog box and fill in a
filename.
3. Click OK to write out the file and open the Attach
Selected Items To E-mail dialog box (described in
the next section).
4. Choose your recipients, fill in a message, and click
Next to open your e-mail program and attach the file.
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E-mail Photos

Images by www.Photospin.com © All rights reserved

One of the easiest ways to share your photos is to e-mail them
to someone, and Photoshop Elements makes this easy. To get
started, pick the photos you want to send and choose File |
E-mail to open the Attach Selected Items To E-mail dialog
box, shown in Figure 1.

You can attach your photos to an e-mail in one of three
formats: as individual attachments, as Photo Mail (HTML),
and as a Simple Slide Show (PDF). Any of these choices enable
you to enter a message in the Message text field. To also load
the images to the Adobe Photoshop Services web site so you
can share them online, select the Also Create An Online Gallery
With These Photos check box.
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E-mail Photos as Attachments
The most common way to e-mail your images is simply to
attach them to an e-mail as files. To send them this way, choose
Individual Attachments from the Format drop-down (visible
in Figure 1). Set up the transmission parameters using the
following options:

■ Use the Maximum Photo Size drop-down list to choose
the size of your photos—from Use Original Size down
to Very Small (320×240 pixels).

■ If any of the images are not JPEG, you can select the

Convert Photos To JPEGs check box to convert them.
This is recommended since the most common other
formats (TIFF, PSD) are huge, and not everyone has a
program that can read a TIFF or a PSD file.

■ If you choose anything other than Use Original Size, you

can set the JPEG quality using the Quality slider—higher
numbers make for bigger files. Once you set these two
quantities, Photoshop Elements shows you an estimated
size of the combined files.

After clicking the Next button, the images are converted (if
necessary) and your e-mail program opens with the image files
attached to a message. The e-mail is already addressed to the
contacts you chose.

E-mail Photos as HTML
Choose Photo Mail (HTML) from the Format drop-down list to
embed the images in the e-mail (your e-mail application must
support HTML-format messages). If you’d like to include the
text captions with each photo, select the Include Captions check
box. Click the Next button to proceed to the Stationery & Layouts
Wizard dialog box, shown in Figure 2.
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Click to expand stationery list

Images by www.Photospin.com © All rights reserved

Click stationery to use it

FIGURE 2 Pick a stationery style from the list
on the left side of the Stationery & Layouts Wizard
dialog box.

Once you pick the stationery you want to use, click the Next
Step button to move to Step 2 (shown in Figure 3), where you
can pick the background color, layout, photo size, caption text
and color, border colors, and whether to show drop shadows
(click the Show Drop Shadows check box).
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Click to open a list of colors and
choose a background color
Pick a photo size

Click to open a list of colors
and choose a font color

Pick a layout format

Images by www.Photospin.com © All rights reserved

Choose the caption
text font from this list

Pick a border color

FIGURE 3 Customize the HTML
document containing your photos.
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Images by www.Photospin.com © All rights reserved

To finish up, click the Next button to open your e-mail
application and embed the HTML photos into a message. This
is what it looks like in Outlook Express:

E-mail Photos as a Simple Slide Show
Choose Simple Slide Show (PDF) from the Format drop-down
list to create an Adobe Acrobat (PDF) file to attach to an e-mail.
As with individual attachments, you can choose the Maximum
Photo Size (use the drop-down list of the same name), and if
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you select anything other than Use Original Size, you can set
the quality from the Quality slider. You’ll also need to provide
a filename for the PDF file that gets attached to the e-mail.
Click Next to show the size of the PDF file, click OK to
create the file, and then open your e-mail application with the
message and file attached.

Create an HTML Photo Gallery
One of the slickest things you can do with your photos is to post
them on a web site. But what if you don’t know how to create
web pages, add thumbnails to them, and set up the links so people
can view the full-sized images? Not to worry, the HTML Photo
Gallery creation takes care of all the messy details for you. Some
galleries consist of a customizable web page with thumbnails of
your images, complete with filename, title, and author if you so
choose. A visitor to your site can then click a thumbnail to see
the full-size image. Other galleries, however, simply display
individual photos full-size.
To get started, select HTML Photo Gallery in the Creation
Setup dialog box and click OK. This opens the Adobe HTML
Photo Gallery dialog box, as shown in Figure 4.

Select the Photos to Use
The first step is to choose which photos you want to use. As
with other creations, any images you selected when you began
building the web photo gallery appear in the scrolling list on the
left side of the dialog box. You can add more photos by clicking
the Add button to open the Add Photos dialog box and choose the
photos you want. You can also remove photos from the list by
selecting the photo and clicking the Remove button.

Specify the Site Style and Banner
The drop-down list at the top of the dialog box provides a list of
HTML Photo Gallery styles. Pick a style to preview the style in
the area just below the drop-down list.
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Web photos are
shown here

Specify the banner
properties

Click to add photos

Pick a gallery style
from this list

Preview the HTML
page style here

Path to the HTML Photo
Gallery storage folder

To set up the basic information for the web site, type the
appropriate values into the fields in the Banner tab (also visible in
Figure 4) and choose the Font and Size for the banner text from
the drop-down lists. Set the path to the site folder where you will
save the web photo gallery by clicking the Browse button and
specifying the path in the Browse For Folders dialog box. The
selected path appears in the Path field. Enter the name of the
folder that will hold the actual web site in the Site Folder field.
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I usually fill in the name of the site folder as the last step before I save. This is because
the web photo gallery changes as I design it, and I want the name of the site folder to
accurately represent the gallery contents.

Set the Thumbnail Properties
Click the Thumbnails tab to display the thumbnails’ properties:

Pick the size of the thumbnails

Set the caption font and size
Select these check boxes to
include this information in the
thumbnail caption

Some gallery styles, such as Classic and Dance, don’t use thumbnails at all, so there is
no point in configuring the Thumbnails tab!

Set the Large
Photo Properties
Click the Large Photos tab to display
the large photos properties.
This tab displays the properties
of the full-size images that are either
displayed on a page or are displayed
when you click a thumbnail (depending
on the gallery style).
If you wish, you can resize the
images so they are all approximately
the same size. To do so, select the
Resize Photos check box and pick an
image size (Small, Medium, Large,
or X-Large) from the drop-down list.
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Larger photos take up more room and take longer to download,
so you should be careful about specifying big images. You can
also adjust the image quality. As with the thumbnail, you can
specify whether to include the Filename, Caption, and Date in
the large photo caption, as well as the font and size to use.
You should seriously consider using the Resize Photos option. If you don’t, the images
are stored at their full resolution, which is usually way too large to display comfortably
in a browser. Because of this, they may take a while to download and display.

Set the Custom Colors
You can choose custom colors for the background, banner, text,
active link, link, and visited link. To set the custom colors, click
the Custom Colors tab:

To set a color, select the colored rectangle, pick the color
you want to use from the Color Picker, and click OK.
It is best not to change the color of the link (hyperlink), the visited link (a link the
visitor has already clicked), or the active link (a link the mouse is hovering over).
This is because people get used to getting cues from the color (such as a purple
link being one they’ve already visited), so changing the colors of these links could confuse your
web-site visitors.
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Save Your HTML Photo Gallery

Images by www.Photospin.com © All rights reserved

FIGURE 5 Preview your web
photo gallery in the Web Photo
Gallery Browser.

Once you’re done configuring your HTML Photo Gallery,
click Save. The entire site is saved to the destination, including
thumbnails, the images (resized if you so chose), and the HTML
files. Once the save is complete, the HTML Photo Gallery
Browser opens so you can preview your site (see Figure 5).

If you chose a gallery that displays thumbnails, you can
view the image associated with the thumbnail by clicking it
in the HTML Photo Gallery Browser.
To preview the web photo gallery in your default browser, navigate to the destination
folder and open the folder you specified in the Site Folder field. Then double-click the
Index.html file.
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Of course, the web pages are still located only on your hard
drive, so they can’t be seen on the Internet. You’ll still need to
upload the pages to your web site, using FTP or your web site
software (such as FrontPage or Dreamweaver). And don’t forget
to provide a link from a page in your web site to the photo
album pages (your web-site software should help you with this).

Build a Bound Photo
Book or Bound Calendar
In Chapter 24, we discussed how to create an Album Pages
creation and a Calendar Pages creation. The main limitation
with these creations is that you don’t have the option to have
them printed professionally. With the Bound Photo Book or
Bound Calendar creations, you can build a photo album or
calendar just like you did with Album Pages or Calendar
Pages, but the selection of templates includes only those
you can have printed online.
The professionally printed albums come bound in a book. You can even order differentcolored leather covers.
To get started, choose Bound Photo Book (or Bound
Calendar) from the Creation Setup dialog box and click OK.
This takes you to the Create A Bound Photo Book (or Create
A Bound Calendar) dialog box. It looks identical to the Album
Pages (or Calendar Pages) dialog box, except that the templates
(listed down the right side) are all available online. Move through
the various steps until you get to the Share panel, where you’ll
notice that the Order Online button is now available. Make sure
you have a connection to the Internet and click the Order Online
button to log into the Adobe Photoshop Services web site where
you can proceed to order the book, including specifying such
special items as the color and type of cover.

Order Prints Online
I can’t tell you how many times I’ve gone to a family function
and had people ask me for copies of pictures I’ve taken. With

P:\010Comp\HowTo8\267-2\web.vp
Monday, December 12, 2005 11:48:29 AM

HowTo-Color (8) / How to Do Everything with Photoshop Elements 4.0 / Plotkin / 226267-2 / Chapter W
Color profile: Generic CMYK printer profile
Composite Default screen

BONUS CHAPTER: Make Online Creations and Share Online
Order Prints Online, it’s easy to set up people as “Order Prints
Targets” and then have prints made and sent directly to them.
You perform all these tasks using the Order Prints palette in
Organizer, shown here.
Discard the target

Edit the target

New target

View photos in
order for contact

Indicates that this is
your home address
Start the process to
order the prints online
This target has this
many photos

If you’ve already added people to your Contact Book, you can import them into the
Order Prints Target list. To do so, click the Choose Existing Contact button in the
New Order Prints Recipient dialog box. This opens the Contact Book dialog box,
where you can select one or more entries and choose OK to insert them into the Print Targets list.
If someone with the same e-mail address is already in the Print Targets list, any additional
information available from the Contact Book (such as their address) is added to the print target.
The first step is to set up the Order Prints Targets. To do so,
click the New button in the Order Prints palette in Organizer.
This opens the New Order Prints Target dialog box, which is
virtually identical to the New Contact dialog box, discussed
previously in this chapter. Fill in the fields (required fields
are noted with an asterisk) and click OK. If this is your home
address, select the This Is My Home Address check box.
From here, ordering prints couldn’t be simpler. Just
select the prints in the Organizer and drag them to an Order
Prints target.
To view the print order for a particular target, select the
target and click the View Photos In Order button in the Order
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Prints palette. This opens the Order Prints For <Contact Name>
dialog box, which contains thumbnails of all the images.

You can adjust the thumbnail viewing size with the zoom
slider, select and remove images from the order, or click Remove
All to empty the order. The dialog box also includes a Confirm
Order button, which, like the Confirm Order button in the Order
Prints palette, starts the process of actually ordering the prints
online (make sure you’re connected to the Internet though!).
If you’ve set up orders for many targets, you can confirm all the orders at once by
choosing File | Order Prints.

Share Images Online
In addition to sharing your photos via e-mail or web pages,
you can post them to the web site at Adobe.KodakGallery.com
(membership is free). Once you’ve done so, you can send
people e-mails that let them know the album is there to be
shared, and provides a link to view the images. They can, of
course, also order their own prints or other photo gifts, which
saves you the trouble of making prints and mailing them.
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To share your photos in an online album, use the following
steps:
1. Select the photos in the Organizer.
2. Click the Share button in the Organizer shortcuts bar,
and then choose Share Online.
3. After a few moments, your Share Online address book
opens, where you can select the recipients with whom
to share your album:

The Click Here To Also Send Prints check box is only available if you have added a
complete address (including a ZIP code) and a phone number.
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4. Select the recipients by clicking the check box to the
left of each entry.
5. If you wish, add a subject and a message in the Message
section. The e-mail that’s sent to each recipient to
announce the album includes this information.
6. Click Next to upload your pictures, create the album,
and send the e-mail to the various recipients. When
the Share Online Confirmation dialog box appears,
you can click the link to view the album.
If you previously uploaded some or all of the pictures for a different album, they will
not be uploaded again, which is a great timesaver.
When a recipient receives the e-mail, it includes a thumbnail
of one of the images, as well as a link to view the album:
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Clicking the link
takes you to the Kodak
EasyShare Gallery
where you can sign in.
Unless the sender
required you to sign
in (by selecting the
Require Friends To
Sign In To View Your
Album check box in
the Share Online
address book), you
can skip this step
and just click the
image thumbnail to
view the slide show.

You’ll need to create an account or sign in if you wish to order prints or buy
photo gifts.

Posting Images on the Web Makes
It Easier for People to Print Them
The main advantage to posting your images in an album on the KodakGallery web site is that
they can be full-resolution, suitable for printing—and you can order prints right from the site
without downloading the images. You can also attach full resolution pictures to an e-mail
(as we saw earlier in this chapter), but that may make the e-mail so large it exceeds the size
limits that Internet service providers place on e-mail. And, if all the recipient wants to do is
order some prints, forcing them to receive a huge e-mail (that may include many images they
don’t want) is just plain rude.
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